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1. Introduction: What Is This Software? 
Minos Maze Maker  is a maze generator 1

that creates myriad mazes and their 
solutions for you to print or use in your 
own publications.  Make them sweet and 
easy, or make them diabolically difficult.  
You will be building and printing 
professional-looking mazes right away. 

Add them to your newsletters, make and 
sell your own books.  The puzzles you 
create are all yours to distribute and sell, 
royalty-free, no commercial license 
needed. 

Your work is safely yours.  Your mazes 
stay on your computer.  Minos Maze Maker never requires you to create an internet account or save 
your work online. 

You can easily change a maze's difficulty level. Change the “Difficulty to Solve” setting and create a 
new maze.  In response, the software automatically adjusts many subtle aspects of the maze for you.  
This lets you quickly fine-tune them, creating different mazes appropriate for anyone. 

You can create, edit, save, and re-open one or more maze document files, just like when using a word 
processor.  Each document saves all the settings and other information to recreate and re-display the 
maze.  When you run the software for the first time, it will open a new maze document with default 
settings for a maze.  You can then change these settings, build a maze, print it, and save the maze 
document to a file on the computer, so you can open it back up later.  This allows you to create, lay out 
and save many different mazes of different shapes and difficulty levels, and return to them later by 
simply opening them from your saved documents. 

There are many features you can customize, including changing size and shapes, colors, path and cell 
style, start and end points, export file formats, etc.  This user guide will explain them all. 

Note: Some features are not available or are limited in the Lite version of this software, and 
some are more extensive in the Pro version.  Those differences are indicated throughout this user 
guide. 

Note: Sections of this user guide can be read aloud to you by selecting the text and choosing 
“Speech>Start Speaking” from the “Edit” menu. 

￼  - The name "Minos Maze Maker" hints at the the story of the mythical Greek king Minos of Knossos, who hid his 1
Minotaur monster away in a labyrinth.
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2.Let's Make a Maze! 
This section shows you how to a) customize a 
maze's appearance; b) change its difficulty; c) 
build the maze; and d) print the maze.  Advanced 
features of Minos Maze Maker are described 
later in sections three and four. 

1. Lay out the size and shape of your maze: 

Tap the "Layout" tab, and under that, tap the 
"Maze" tab.  
Change the maze 
size (number of 
cells across and 
down) to 31x31, 
and change the 
maze shape to 
“UpArrow".  Tap 
the "Cell" tab and 
set the cell shape 
to “Hex (Sigma)”. 

2. Choose how the Solution path will be 
displayed: 

In the "Layout:Solution" pane, set the 
“Show Maze Solution Path as:” to "Line”, 
and choose a Blue color for the Solution 
Path color. 

3. Now choose how difficult the maze will be 
to solve.  Under the "Difficulty" tab, move 
the “Maze Difficulty” slider to nine, for 
"pretty difficult”: 

4. Tap the "Build" button at the bottom of the 
window, or type ⌘-B to build the maze, and 
wait a moment for it to build.  Near the top 
of the window, set the "Maze Preview as:" 
to "Solution", and here is your maze, ready 
to print! 

The Preview will 
show something 
like this, with a 
different solution 
path.  You can tap 
the Build button a 
few times to see 
how it creates a 
different maze and 
solution path each 
time, and stop 
when you see one you like. 

5. Tap the “Print” button at the bottom of the 
window, or type ⌘-P, and you should see 
the Print Preview screen, ready to print your 
maze. 

Oh, but wait… there is so much more you can do 
with Minos Maze Maker.  Keep reading and 
learn how to unlock many more powerful 
features. You will quickly be creating world-
class mazes! 
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3.Where Is Everything? 
This section gives you a general idea of the names and positions of the the software’s main areas and 
their names in this user guide. 

Main Menu Bar 
When you start Minos Maze Maker, the main menu bar at the top of the screen is replaced with menus 
that are just for this software.  Within these menus are many different actions that let you open, save, 
and close maze documents (just like a word processor).  You can also customize the application’s 
behavior when opening a maze.  Other commands let you start and stop building a maze, bulk-build 
mazes, export the created maze puzzle and solution files, and even open this user guide or send me an 
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e-mail.  A complete explanation of these commands can be found in the section "Menus at the Top" 
linked here. 

Document Window 
The document window contains all your customized settings to build a maze, including the size and 
shape and colors of the maze.  In addition to letting you customize the settings, it also shows you a 
quick preview of the final maze puzzle and solution.  This document can be saved as a file, and re-
opened later. 

Maze Settings Tabs 
The left side of the window contains a number of tabs you can tap to switch between different sets of 
controls.  Each set of controls lets you customize the maze with colors, fonts, sizes and shapes, a Maze-
Phrase, and other options.  As you make changes, the Preview area will update to show you how the 
maze will look.  The different controls under each Settings Tab are all explained in the section "Maze 
Settings Tabs" linked here. 

Preview Area 
The right side of the window displays a preview of what your final maze (and solution) look like, with 
the title and maze displayed in the fonts and colors you chose in the Control Tabs area.  You can read 
more details about the Preview area in the section "Maze Preview" linked here. 

Action Buttons 
The array of buttons at the bottom right corner of the document window offer you quick access to the 
actions you most often take with the software, i.e., building a maze, printing/exporting it, and opening 
this user guide.  These actions and others can also be accessed from the Action menu on the main menu 
bar.  You can read more details about these buttons in the section "Action Buttons" linked here. 

___________________________ 
Minos Maze Maker - User Guide Page ￼  of ￼4 66

_________________________ 
Copyright 2025, SchwanSongs

http://www.schwansongs.com


4.Help: Tell Me How To… 
Here you will find answers to many questions you may have, which will help you make more 
beautifully unique mazes with this software. 

Make a Really Easy Maze 
Here are several suggested settings to make easy-to-solve mazes. 

Under the Layout tab, choose a small number for Maze size, perhaps between eight and twenty.  Note 
that you can only choose different Maze shapes if you choose a Maze size of ten or higher.  Choose a 
Cell shape of Square or Triangle.  You may want to choose a larger Wall Line width so they are easier 
to see. 

Under the Start/End tab, choose to show the markers as “Start and End Letters”, or just choose “Circle 
Dots” and tell them to connect the two circles.  You can also change the Start/End marker size.  For the 
Solution Markers, choose “Arrows” or “Line”. 

Under the Difficulty tab, set the Maze Difficulty to something between one and five. 

Change the Maze Preview at the top to show “Solution” so you can quickly see how the maze is built. 

Now, press the “Build” button in the lower right corner to create a maze.  If you don’t like that one, 
press the Build button again.  Each time you press it, a new maze will be built with a completely 
different solution path. 

Make a Really Hard Maze 
Here are several suggested settings to make difficult-to-solve mazes. 

Under the Layout tab, choose a larger number for Maze Size, perhaps between twenty and forty.  Note 
that the larger the size, the longer it takes to build a maze, and the smaller the cells are, in order to fit 
the entire maze onto a single printed page.  Choose a Cell Shape of Hexagon, for more dead-end path 
possibilities. 

Under the Layout:Wall tab, turn up the "Line Wiggliness". 

Under the Layout: Solution tab, choose “Arrows” or “Line” for the Solution Markers. 

Under the Difficulty tab, set the Maze Difficulty to a high number, between eight and eleven. 

Change the Maze Preview at the top to show “Solution” so you can quickly see how the maze is built. 

Now, press the “Build” button in the lower right corner to create a maze.  If you don’t like that one, 
press the Build button again.  Each time you press it, a new maze will be built with a completely 
different solution path. 
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Move the Start and End Points Elsewhere 
The maze software will automatically pick default start and end points for every shape.  It always 
chooses the start point at the far upper left corner, and the end point at the far lower right corner.  But 
you can change them to be at any cell in the maze, even somewhere inside the shape, not on an edge if 
you wish. 

You can move the mouse pointer over either the Start or End marker, and tap-down and drag it to a new 
position, and let go to drop it in its new spot.  Do the same with the other marker. 

You can move either marker to any place inside the maze shape, either along an edge or even 
completely inside the shape.  If the marker is on an edge and there are multiple walls to choose for the 

start or end direction, then you can tap on the “Start Cell Wall opening” 
button or the “End cell wall opening” button to rotate through and choose 
which wall you want opened.  If you have dropped a marker onto the shape in 
a cell where it is not touching any outer walls, then the button will be dimmed 
and show a “no entry” icon, as shown in the “End cell” button here. 

When you move the markers, you are invalidating any maze and solution that is already built.  This 
means that when you move a marker, the maze is immediately cleared and you must re-make a new one 
using the new start/end spots. 

Also, if you change the maze shape or size or cell style, the markers will be automatically reset back to 
their default positions. After you change the maze shape or size, if you want them back in your favorite 
custom spot, simply drag them back again. 

Note: If you have set the “Show the Start/End Markers as” (under the Layout:Start/End tabs) to 
“Do Not Show”, then the markers will be shown in the Preview area as a light transparent color.  
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That way you can still find them in the preview area and drag them around to where you want 
them. 

Note: Once you have set a maze shape, size, difficulty, and moved the start/end markers to a 
new spot, you can choose the “Save as Default Settings” menu item to remember all these as 
starting settings for all newly created maze documents. 

Make a “Maze-Phrase” Puzzle 
The Maze-Phrase feature works by letting you first design a maze any way you like, easy or hard, any 
shape and size.  You then select the Maze-Phrase tab and type in a phrase that will be 
laid down, letter by letter, along the solution path of the maze as it is built. 

When it builds the maze, it lays your phrase out into the maze from the Start 
position to the Finish position along the solution path.  The other dead-end 
paths of the maze will be filled with “almost” the same letters in your 
phrase, with a letter or two swapped around so that there will be only one 
complete properly-spelled phrase in the puzzle.  The higher the difficulty 
of the maze, the farther along the dead-ends you go before the incorrect/
swapped letters appear.  This allows your puzzle solving user to go farther 
down wrong paths before they notice the phrase is wrong. 

Notice that your phrase of letters must be shorter than the total number of solution maze cells/steps 
from the start to the finish, in order for it to fit.  If your maze has an “easy” difficulty setting, the 
solution path is fairly short and direct.  If your maze has a “hard” difficulty setting, the solution path 
will be more windy, and have more space for a longer phrase.  This will help you decide how many 
letters you can use. 

If your phrase is too short or too long to fit 
along a solution path, then when you build 
the maze it will fail and display an error 
message.  It will give you extra 
information about how close the phrase 
was to fitting, so you can then adjust the 
phrase length or the maze size or cell style 
or the difficulty and try to build again. 

If you have the “Exact-Fill” checkbox turned off, the letters of your phrase will be spaced out to evenly 
stretch from the Start to Finish markers.   The extra fill letters along dead-ends will also be stretched 
out in the same way, so the correct-solution and dead-ends will all look similarly populated. 
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If you have the “Exact-Fill” option turned on, then Minos Maze Maker will try to build a solution that 
is exactly the same number of cell steps as there are letters in the phrase.  This means there will be a 
letter in every single cell of the maze.  It will take into account your Difficulty setting and build a maze 
at that difficulty, while finding a solution exactly the length of your Maze-Phrase. 

If creating the maze and finding an Exact-Fill solution of your phrase is impossible or impractically 
time-consuming, then building the maze will fail and display an error message.  The error message will 
give you information about how far off the length is (too long or short), and will suggest ways you can 
try to fix it.  If your Maze-Phrase length is within a single letter or two of the solutions found, you 
should simply re-build the maze again, and it will likely find the perfect solution next time.   

Note: “Exact-Fill” Maze-Phrases will will be unsuccessful more often if you choose very short 
phrases and small mazes.  You can help “Exact-Fill” succeed more often in these cases by 
increasing the phrase length and maze size a bit, or changing the “Difficulty” setting, or moving 
the start/finish markers, then re-building the maze. 

So, set up the maze, shape, colors, difficulty any way you like.  Keep in mind whether you want 
“Exact-Fill” or not.  Exact-Fill will require you to more carefully match the length of the phrase with 
the number of cells between the start and finish positions, start and end positions, and difficulty level. 

Select the Maze-Phrase tab and enter the phase you want.  As soon as the Maze-Phrase text is not 
empty, a little tag will show up in the Preview area, showing that the “Maze-Phrase” feature is 
activated.  If you do not want to use a Maze-Phrase, simply delete all the text in the Maze-Phrase text 
box. 

Then tap the Build button to create the maze.  If the phrase is too long, or if you have 
turned on “Exact-Fill” and the phrase doesn’t exactly fit, an error message 
will display showing how many letters you must add/remove.  Make any 
changes and build the maze again until it succeeds and looks the way you 
like. 

You can change the solution key to show the Maze-Phrase letters along 
the solution path.  Simply select the “Layout” tab and the “Solution” tab, 
then set the “Show Maze Solution Path as:” menu to one of the “Maze-
Phrase Letters” options.  You can now display the Solution Preview and see 
your Maze-Phrase letters laid out along the solution path. 

You can dive deeper into Maze-Phrases in in the section "Maze-Phrase Tab" linked here. 

Save a Maze Document to Disk for Later 
If you have customized the layout of a maze, save your work to a document (file) on your computer.  
Then you can either open it or print more copies later.  Do this especially if you want to save your 
changes or want to share your puzzle with a friend who has Minos Maze Maker. 

Documents can be saved even if you've not yet built a maze.  This allows you to quit the application, 
but then later return to the maze document to finish working on it. 
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• After making changes to the document, choose “Save” from the File menu. 

• You will be prompted for a file name and directory location, depending if this was a new document 
or it was your first time saving it to disk.  Type in a file name, choose a location on your disk, and tap 
the save button.  The file has now been created. Your maze settings are stored within it. 

• Alternatively, if you have opened an existing document to make changes, saving the document would 
quietly update it in place.  It would update the information and not prompt you for a file name. 

The saved document will look like this on disk: 

The document will stay open after you save it so that you can keep working on it. 

Note: The File menu has an “Open Recent” menu item that lists documents you have recently 
worked with.  You can simply choose one of your recent documents here and it will instantly re-
open for you. 

Save your Customized Settings for All Future Maze Documents 
You may find that every time you start the software, you always go in and change certain settings the 
way you like.  You would prefer that the software to remember your custom settings and open every 
new maze for you this way.  Minos Maze Maker can do that for you! 

Simply open a document and change all the settings to you want all documents to start with, and then 
choose “Save as Default Settings” from the Minos Maze Maker menu.  It will remember every setting 
(size, shape, difficulty, colors, page title and font, etc.) and use them for every subsequent new maze. 

Any time you want to change these “default” values, simply do those steps again and it will update and 
use your new settings. 

Make Several Groups of Similar Mazes 
You may want to set up multiple “default” settings and be able to quickly switch between them, to 
create a group of mazes that all look similar.  For example, you may be creating a book of mazes with 
three sections, EASY, MEDIUM, and HARD.  You want eleven EASY mazes of easy difficulty and 
smaller size, and nine MEDIUM mazes of medium difficulty and moderate size, and eight HARD 
mazes of harder difficulty and a large size. In this case, it is best to create and save three separate maze 
documents, each with its own settings.  These maze documents can be thought of as “template” files 
that each hold particular settings for a group of mazes. 

For the above example, simply create, update and save a first maze document with the EASY settings 
for the first eleven mazes. Then, create and save a second new document (you can duplicate the EASY 
maze file from the File menu or in the Finder, and rename the copy to MEDIUM, for example) with the 
MEDIUM settings, and create a third document for your HARD settings.  Now you can open the first 
EASY document and create and save eleven EASY mazes from it.  Next, open the MEDIUM 
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document, and make nine different MEDIUM mazes from it, and open the HARD document and make 
eight HARD mazes from it. 

Note: If you are using the Pro version of the software, you could instead open the EASY 
document and choose “Bulk-Builder” to set up and automatically make the eleven EASY mazes, 
then do the same for the MEDIUM and for the HARD document.  See this linked section for the 
Bulk-Builder. 

If you wish to save each of the eleven mazes as separate documents, use the “File” menu’s duplicate 
command.  Make eleven new copies of the original document, rename each one and build each maze.  
Do the same with the second template document to make twenty-two duplicate copies of it. 

Note: You can even open both documents at the same time in different windows for comparison. 

Reset your document’s settings to saved “factory defaults” 
If you have made a bunch of changes to your document but now want to quickly restore all its settings 
to the saved default set of values, there’s a menu item for that!  Choose the menu item “Reset 
Document Settings to Defaults” under the Minos Maze Maker main menu. After you choose this, your 
currently opened document settings will all revert to the currently saved “default” settings for this 
software. 

Print the Finished Maze and Solution to the Printer 
After you have opened a maze document and created a layout that you like, it is time to print the maze 
and its solution to the printer.  You do not need to save your document to disk before printing, however, 
it is usually a good idea to save your work from time to time, and just before printing is a good time.  
To save the document, follow the instructions in the section "Save a maze document" linked here, then 
continue reading this section. 

Go to the “Printing” tab and choose to print the maze, its solution, or both. 

You can now print by either: 

• Tapping the “Print” button at the bottom of the main window. 

• Or choose the “Print...” item under the File menu, and tap the Print button. 

• Or press the <Command>-P keys on the keyboard. 

Make any changes you need in the print dialog, and tap the Print button. 

You could instead choose to save the maze and solution as a PNG or PDF files (for attaching to an e-
mail, for example).  See the next section for how to do this. 
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Save/Export High Quality Maze Files for Publication 
Your newsletter may be yearning for a maze page, or perhaps you want to add your own logo and text 
around a maze.  You may want to create a number of different mazes, and publish them in a book.  In 
these instances, you will want to extract just the maze image, and its associated solution image. You 
will need to import them yourself in a separate word processing document. Then, you can do your own 
page layout of them. 

Note: The export command will export just the maze puzzle and maze solution images.  The 
exported files will not include margins, and they will not (normally) include your title or your 
Maze-Phrase prompt, since it is assumed you will be laying out the maze with other elements on 
the page in your own artistic way.  You can choose to export the maze with its title by turning on 
the “including Title…” checkbox from the top of the export window. 

Exporting gives you additional file format options, and higher resolution/quality options. These are 
useful when importing to other publishing software. After exporting, you can import those files into 
software where you can nicely format them for publishing.  For this more flexible work-flow option, 
here is how you can export the mazes and their solutions to separate files. 

First, choose the settings for the size, shape, and colors for your maze, and then build your maze.  You 
may want to save this maze document once you like it, in case you need to open it later and change and 
re-build and re-export the maze file… you know, in case one of those eagle-eyed editors requests a 
minor change. 

If your final book will be printed in black and white, then there is no need to choose colors for lines 
and markers, set them all to black/white/gray by choosing the “Change all colors to B&W” menu item 
under the Minos Maze Maker menu.The maze is normally drawn using solid/opaque lines for the walls 
and transparent areas for the inner cell areas.  This is useful if you want to lay the maze on top of some 
other background in your book and let the background show through.  However, you may instead want 
the background behind the maze to be a solid opaque color.  That way it will block out the background 
inside the maze area.  You can make mazes either way to suit your purpose. 

To get a transparent background, go to the Layout tab and turn off the “Add Cell Floor Color” 
checkbox. 

To get a solid color background, turn on that checkbox, and choose a solid color by tapping the color 
rectangle just to the right of the checkbox. 
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Once you have built a maze and have chosen an export format, choose “Export Maze…” from the File 
menu, or use the Export button on the window.  You are shown a window on your maze document: 

This window lets you choose which files to export, and which directory to write the files to.  Near the 
top of the window is a box holding the proposed filename example and the currently chosen file size 
and format.  This will update as you change any of the settings below. 

Note: Your changes to these settings will be remembered in this document for future exports. 

Export the Puzzle file: Export will always write the Puzzle file.  You can optionally tell it to write the 
Solution file too. 

[✓] including Title & Maze-Phrase prompt: Normally only the maze puzzle itself is written out 
when you export the maze puzzle image’s file. Later you will add your own title as well as the word 
list’s text around these puzzles.  However, if you turn on this checkbox, the exported puzzle file will be 
a slightly narrower rectangle size. It will add the title above the puzzle, placing the Maze Phrase 
prompt below the puzzle. It will include the font, color, size, and formatting you specified in the 
“Layout” tabs.  This is more convenient if you're constructing multiple puzzles for a book. Moreover, 
this implies that you are satisfied with Minos Maze Maker’s layout of the title, subtitle and Maze Phrase 
prompt for the puzzle.  Keep in mind, though, that this will only add the title and Maze Phrase prompt 
to the puzzle file; not the answer file. 

Note: The exported puzzle file layout will always be “Portrait Mode.” Titles will be listed 
above, with the word list below.  Export file layout is not affected by the “Printing Layout” tab 
to print puzzles in “Landscape Mode.” 
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[✓] and Solution File: The puzzle file will always be exported, and here you can optionally write the 
solution file too.  The exported puzzle and solution files will have the same file names, with the added 
suffix of either “_Puz” or “_Ans”. 

[✓] and ESP File: (Pro Feature) This is a JSON-formatted text file that is easily imported into other 
computer software.  It contains all the puzzle and solution information needed to re-create the puzzle in 
other software.  These files can be imported into your publishing workflow to lay out a large number of 
puzzles where you will want them re-formatted and flowed onto pages in your own way.  Or they can 
be collected and imported into your own interactive game-player engine on the web or in your mobile 
app.  See the Help menu item “ESP File Guide” for detailed information about this file format. 

File Size and Format 
Width and Height of exported graphic file…:  This "size" setting lets you choose how large the 
puzzle image will be when you export it.  This is only used for the image formats (PNG, JPEG, PDF, 
SVG.)  The text-based formats don't need or use it. 

Note: There are fewer export sizes and file formats in the Lite version of this software. 

Puzzle export file format:  You can choose what file format to use when saving your exported puzzles 
and solution keys. 

• PDF:  This is a high quality (vector) publishing file format, readable by many word processing and 
page layout applications. 

• PNG, JPEG:  These are graphic image file formats. These are readable by many photo and image 
editing programs, as well as word processors and page layout applications.  PNG supports 
transparency, JPEG does not. 

• POV-Ray: A text scene description language used by the freeware “POV-Ray” ray tracer to generate 
photographic-quality three-dimensional (3D) images (or animated movies) of a scene.  See 
www.povray.org for more information.  Here is an example of an exported maze, which is then 
rendered into an image with POV-Ray: 

• SVG:  This is a vector graphic file format. It can be re-sized without losing any quality.  Many web 
browsers, Amazon Kindle, and some page layout or graphic editing applications can read these 
images.  SVG files are non-interactive, but can be directly added to a web page, or imported and 
used to develop an interactive game. They may even be imported into CNC or 3D printing machines.  
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Let your creative imagination think about these possibilities!  It is important to note that SVG files, 
unlike PDF and PNG/JPEG files, cannot capture and use your computer’s fonts for drawing letters. 
Therefore, the fonts used in SVG files are a “suggestion” for what to use on the end-user’s computer.  
You can change the font-suggestion for SVG files by selecting one from the SVG “Letter Font” 
menu under “SVG Info” in the Application Settings window. 

File Naming 
File name text: This string will be used as the main part of all your export file names. 

Use Default Filename: If you saved the current document, this button resets the value of the “file 
name text” to the currently saved document's file name, or to the generic "MinosExport". 

Add export-counter to exported file name: Turn this on to add an export counter into the file name 
that increments upon each export.  Therefore, you can build multiple puzzles with the same puzzle 
setup, exporting each puzzle with unique file names, “MyPuzzle_Puz_1.png”, “MyPuzzle_Puz_2.png”, 
“MyPuzzle_Puz_3.png”. 

Note: To display this counter in the title of your puzzles, see the puzzle-macro $$exportcounter 
in the section “Use Auto-Updating Puzzle Macros.” 

…, Starting At: If “Add Export Counter..” is turned on, then you’re able to choose a starting value for 
the export counter mentioned above. For example, if you set this to 222 then, every time you start the 
application and start exporting, your first exported puzzle file will start with that export-counter value 
(“MyPuzzle_222_Puz.png”).  Each time you export again, the subsequent files will get the next-higher 
export number, e.g., “MyPuzzle_223_Puz.png.” 

Note: You can reset the internal counter back to your starting value by simply re-typing the 
starting value in the text field. 

File name layout: This pop-up menu lets you format the exported file names with the above 
components in a particular order. Ultimately this will change how they are sorted and grouped in the 
Finder.  As you change this pop-up setting, the file name at the top of this window will update and 
show you the new layout. 

Destination Directory 
Choose directory for export files: This lets you pick a directory to write all your exported puzzle/
solution files. 

Reveal directory in Finder: After you have chosen a destination directory, tap this button to open and 
display it in Finder.  This is a quick way to access the exported files. 

Warn if about to overwrite existing files: This warns you if you’re about to overwrite an existing file. 
If export finds a file with an identical file name, it will pop up a dialog.  This allows you to either 
overwrite or skip this one or all duplicate files. 
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Design Your Own Shape for a Puzzle (Pro Feature) 
You can design and edit your own shape, and then build a maze 
with it! 

First, select the “Layout” tab.  Next, choose “Design  Your Shape” 
under the “Maze” tab in the Maze Shape box. Then, tap the 
“Launch Shape Editor” button.  You can also create a shape by 
going to the top “Action” menu and choosing “Shape Editor.” 

The “User-designed Shape Editor” sheet is now presented on top 
of your current maze document.  It lets you design or edit your 
own shape for your maze. 

Make a company logo, an animal, a tree, a holiday shape, or just about anything you can imagine.  The 
"Shape Editor” lets you draw the shape in large puzzle resolution (50x50) in the “Design & Edit Here” 
grid on the left. It also shows you a preview of different puzzle sizes in the “Preview Here” grid on the 
right.  If you make a mistake while drawing, erasing, or filling the design area, choose “Undo” from the 
Edit menu. It lets you back up a step or more.  Opening the “Shape Editor” from a document with an 
already-created user-designed shape allows that shape to load into the program. Therefore, you can 
easily edit it.  There is only one user-designed shape in each maze document. 

Note: Every edit action you take in this sheet is “undoable.”  You can switch pen size and draw 
a few strokes. Choose “Undo” from the “Edit” menu to undo those changes, essentially “backing 
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up” to prior versions of the shape.  Simply use the “Undo” menu item under the “Edit” menu to 
undo each change you made. 

Shape Name/Designed By 
Add a “Shape Name” and add your name/copyright to the “Designed by” text fields.  They will be 
saved with the shape if you export the shape file. 

Design & Edit Here 

Pen Size (Radius) 
This lets you change the pen size to draw/erase with.  The left side makes you draw smaller, the right 
side lets you draw larger. 

Display some ruler guides 
Turn this on to display faint ruler lines inside the design grid to help you line up your drawing. 

Mouse clicks will Draw/Erase 
You can select the mouse-dragging behavior to either draw or erase. Drag the mouse around the 
“Design and Edit” grid with the mouse button down to make your shape. 

You can hold down the <Shift> key while drawing along horizontal & vertical axis lines. 

You can hold down the <Option> key while drawing along diagonal axis lines. 

Fill Shape/Clear Shape 
You can completely fill or completely erase the shape area with these buttons. However, as you click 
these buttons, you will first be asked if it is OK to wipe the shape clean. 

Fill with Shape: 
The shape area can be filled with a pre-defined geometric shape, which makes it easier to create your 
own custom shape. When you select a shape from the pop-up menu, you will first be asked if it is OK 
to wipe the prior shape clean. 

Preview Here 

Puzzle Preview Display Size 
Moving the “Puzzle Preview Display Size” slider to different sizes shows hows how the puzzle will 
appear.  This lets you fine-tune your drawing so it works well at a specific dimension/ range. 

Import 
 This button will load a “.ssuds” shape file that you or somebody else created earlier into this design 
window session.  For more information on the .ssuds file go to this linked section. 
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Export 
This button will save a copy of your current shape as a separate file, which can be imported later into 
this software or other software products that read this file format.  For more information on the .ssuds 
file go to this linked section. 

Save/Cancel 

Save 
Save your shape back into your currently-opened document.  Once saved, the "Shape Editor” sheet 
closes and the shape you have designed is shown in the “Preview” window. You can now make mazes 
from it.  If you save this document to disk as a file, your user-shape is saved inside it as well. Both will 
be available when you re-open your document later. 

Cancel 
Throws away your current edits, closes the “Shape Editor” window, and leaves the document’s user-
designed shape unchanged. 

Exported .ssuds Shape File Format 
Upon exporting your user-designed shape, it's saved in a special file format that can be read/imported 
by any other SchwanSongs software supporting this format.  Currently the only two SchwanSongs 
software applications that support this format are Minos Maze Maker Pro and Whirlwind WordSearch 
Pro. 

The “.ssuds” file extension stands for “SchwanSongs User-Defined Shape.”  The file itself is in XML 
format, specifically an Apple .Plist file format.  It consists of a dictionary of key-value pairs. These 
define the version of the file, the name/credit strings, width/height dimensions, and the actual two-
dimensional bitmap of the shape in Base64 encoding.  If you are interested in parsing this yourself, e-
mail me a request.  I can send you the specification details. 
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Bulk Build Many Mazes at Once (Pro Feature) 
Bulk building is most useful for creating a large number of puzzle image files that you will later import 
and arrange into your own book, newsletter, or web page. 

When you choose “Bulk Builder” 
from the “Action” menu, a sheet 
is presented on top of your current 
puzzle document.  This sheet lets 
you configure and then 
automatically build a large 
number of different puzzle and 
solution files. Bulk Builder will 
then save all the completed files 
in a directory you choose.  These 
files will be the exported image 
files, and optionally other 
informational files you choose to 
export. 

Designs 
Here is how the “Bulk Builder” works.  Let’s say you want to quickly make ten different puzzles, each 
with a different difficulty level.  I will call each of these ten puzzles it creates a “design.” 

Variations 
For each of these designs, you can optionally have it build one, two, three… up to five different 
“variations” on that puzzle design.  In other words, for each design, it will re-build that same puzzle 
(with the same difficulty and layout) and save it as a new variation. It’s as if you simply tapped the 
build button again to get a new layout of the same puzzle .  For example, if you ask for three variations 2

of each design, it will generate your ten designs with three variations each. There will be a total of 
thirty (ten times three)  different puzzles for you.  This lets you review and choose your favorite 
variation for each puzzle design without having to re-run a new bulk build if there was just one puzzle 
design that you didn’t like. 

 As you know, sometimes a second or third “re-build” of a puzzle gives a more interesting layout, and this allows 2

you to automatically make several layouts (variations) and you can then review and choose the best one after they 
are all built.
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File Naming 
“Bulk Builder” will name each file with a number for the design, followed by a letter for the variation.  
Given the example above with ten designs and three variations, you will get exported files named: 

MyPuzzle-1a, MyPuzzle-1b, MyPuzzle-1c, 

MyPuzzle-2a, MyPuzzle-2b, and MyPuzzle-2c, … up to: 

MyPuzzle-10a, MyPuzzle-10b, and MyPuzzle-10c. 

Preparing a Puzzle for Bulk Building 
Before starting a “Bulk Builder” session, you must first set up a Minos Maze Maker document with the 

basic settings you want to use for the puzzles in this bulk run.  
This document will be your “starting template.” The puzzles 
created during this run will each start out with the layout you 
have set up in this document.  Then Bulk Builder will use your 
settings to change certain settings of each created puzzle.  You 

do not need to save this “template” document 
to a file or even build a 
puzzle from it. However, 
you may want to initially 
build a puzzle with it in 
order to preview how it 
looks before commiting to 
the bulk build. You can 
optionally save this 
document so you can easily 
load it back up later to re-
run the bulk process. 

Note: If you do not want “random” changes to settings, but instead want several groups of 
puzzles sharing the same settings (for example, 20 easy puzzles, 20 medium puzzles, and 20 
difficult puzzles) then you can combine the Bulk-Builder feature with the “Multiple Template 
Documents” idea described in this linked section. 

To prepare, first open a new document and choose the basic settings you want to use for this group of 
puzzles.  Every bulk-built puzzle will start with these settings. 

Now you are ready to configure the settings for the bulk run.  Choose “Bulk Builder” from the action 
menu and open it.  The settings are separated and grouped under four main tabs. 
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How Many 
This tab lets you choose how many maze designs and their variations to create in this bulk run. 

Number of Maze Designs to Build 
Choose the number of unique maze “designs” you want to bulk-build.  When you start the run, the 
settings that you choose below for each puzzle design will randomly change as it builds each maze. It 
saves the corresponding puzzle file (and an answer & info file) for each design it builds.  Each puzzle 
design will be numbered, 1,2,3, etc. 

Number of Variations of Each Maze Design to Build 
Normally you may only want one maze built for each design.  But there may be times when you want 
to choose the best from several variations of each puzzle design.  Let’s say you want to build forty-two 
mazes, but you know that you don’t always like the particular random solution of any given maze. 
Therefore, you want a few extra variations of that maze design.  You can do this by choosing to create 
more than one variation for a design. 

If you choose five variations, then the bulk operation will build forty-two maze designs. For each 
design it sets up, it will build and save five different mazes with that design.  In all, a total of 210 
mazes will be created. Each of the maze design files will be numbered 1,2,3…42, but they will now 
also have the five variations added to their filenames as a, b ,c, d, and e.  So the files will be named: 
MyMaze_1a, MyMaze_1b, MyMaze_1c, MyMaze_1d, MyMaze_1e, MyMaze_2a, MyMaze_2b, etc. 

When the bulk build is complete, choose your best variation (a-e) for each of these forty two maze 
designs. 

Continue Building if Errors Occur 
Normally, if there is a problem building or writing a maze's file during this long run, immediately stop 
running the bulk builder. Then, you can fix the problem and restart it.  However, if you want it to 
ignore an error of one maze and just charge ahead making the rest of the mazes, you can turn this 
checkbox on.  Any maze that cannot be built will instead write an error text file with information about 
the maze and why it had a problem.  This may be useful if you are trying to build many Maze-Phrase 
style mazes, where sometimes the message doesn’t fit the particular randomly chosen puzzle size/
shape. In this case, you want to ignore the problem and keep building the other maze designs. 
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Randomize Settings 
This tab lets you select a number of maze settings in your document to randomly change for each maze 
design that is built.  If you leave a checkbox off here, it will simply use the setting from your 
underlying maze document for every generated maze in the bulk session. 

Sizes 
You can leave the “Choose…” checkbox off to create all puzzles using the underlying document size 
setting you have.  Or, you can turn on randomness and it will randomly pick any puzzle sizes within the 
size range you choose.  If you set the lower range to something below ten (the smallest size that allows 
shapes), then any puzzles that happen to randomly get created below a size of ten will default to a 
square shape, no matter what you set for puzzle shape. 

Shapes 
You can turn on any number of the pre-defined geometric 
or alpha-numeric shapes to build mazes from.  Minos will 
choose a different shape from your list for each maze 
design it creates.  If you have asked for more mazes than 
maze shapes, then after Minos uses all your shapes once, 
it will reset the list and start choosing from your list of 
shapes again. 

You can bulk-build mazes from your user-designed shape 
instead.  Simply choose your user-designed shape in the 
document under the “Layout:Maze:Maze Shape” tab, and 
turn off “Choose random maze shapes” here in the Bulk-
Builder window.  Your user-designed shape will then be 
used for all bulk designs. 
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Other Settings 
This has a number of other settings that you can select to be randomly chosen for each maze it creates.  
If you turn one of these on, that setting will be randomly set for each maze.  If you turn it off, then all 
mazes will use the same setting from the underlying document. 

You can enable a random range of difficulty settings, random start/end positions, random cell shapes 
and random amounts of wall-wiggle for each puzzle design. 

Bulk Maze-Phrases 
This tab lets you type in a list of Maze-Phrases (and other commands to help guide the bulk-builder 
process), or leave the text box empty to bulk-build regular non-Maze-Phrase mazes instead.  The text 
can be typed in, or copy/pasted from another document.  These text lines are automatically saved/
remembered between bulk builds with your document. 

Tap the circle “help” button near the top of this tab area to open and view a document. This describes 
the technical format of the text and commands in the bulk-maze-phrases text area, showing you how to 
format this text list. 

Note: You can also access this little guide any time by choosing “Bulk Builder Guide” from the 
Help menu. 
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Tip: If you want to automatically add the current puzzle design counter into your title (e.g. 
“Easy Puzzles - #1”, “Easy Puzzles - #2”,) you add the magic “puzzle macro string” $
$designcounter into your Bulk Word list #mazetitle command, and it will get automatically 
filled in for you as you bulk-build the files.  See the “Puzzle Macros” section for more 
information. 

Load and Check: After entering your maze-Phrase list, tap this button to load the text lines and 
prepare them as the Maze-Phrase text lines for the mazes.  The first maze design will use the first line 
of text as a Maze-Phrase, the second maze design will use the second line, etc.  If a line is left blank or 
there are fewer lines than mazes, those mazes will become regular mazes, not Maze-Phrase mazes. 

Ensure you entered everything error-free.  If the lines loaded alright, then you will see a green dot after 
the “Load and Check” button.  If there was a problem, then there will be a red dot and an error message 
next to it, explaining what went wrong. 

The Maze-Phrase settings from your current document will be used to determine how to build the 
Maze-Phrase (font, exact-fill, etc.)  This text that you enter will be saved with the document and 
remembered between bulk runs. 

Note: This list of Maze-Phrases is completely separate from the single Maze-Phrase text in your 
main document.  If you wish to use the Maze-Phrase from your document here as well, then 
simply close this bulk-builder window, switch to the “Maze-Phrase” tab and copy the Maze-
Phrase from that text box.  Then re-open this bulk-builder window and switch to this “Bulk 
Maze-Phrases” tab, and paste in the Maze-Phrase to this text box.  The single Maze-Phrase will 
then be in these two separate spots.  You can add to this Bulk Maze-Phrases list without 
affecting the main document’s Maze-Phrase. 
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Export Files 
This bulk-builder tab is almost identical to the regular export dialog.  (To read more, see the section 
"Save/Export" linked here.)  Though, it is used by the bulk builder instead. 

The only difference is that the “Add Export Counter” setting is always on for bulk runs, so, each 
exported maze design will be uniquely numbered.  It lets you choose various settings related to the 
destination files that are exported for each puzzle, for example what file format to use, what the 
filenames should look like, and what directory to write them all to. 

Start Building Them All 

Start 
Finally, tap the Start button. The mazes will be built and exported one by one, along with their puzzle 
and answer files. The files will all be saved to the export directory you chose.  If your maze dimensions 
are large, this can take several minutes to build a lot of large mazes. 

As it builds each maze, the preview area will display the current puzzle it is working on.  There is also 
a visual indication of completion via an upper progress bar for the entire build job. A lower progress 
bar shows progress for each maze being built.  It will also attempt to refresh the preview area behind 
the bulk window as each maze is built. 
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Stop 
If you want to stop the build process partway through, simply tap the stop button. It will stop building 
mazes.  It will cleanly stop, and any existing maze files that it has already built will remain in the 
directory.  When you start the bulk-build process again, it will restart from the beginning, and attempt 
to overwrite any prior files. 

Save Settings as Default  
Once you have all the bulk settings arranged the way you like, you may want to tap the Save Settings 
as Default button to save all the current settings into your document.  That way, all future new mazes 
you create will start off with these bulk settings. 

Bulk Building - Additional Notes 
If you have a regular Maze-Phrases set up in your document, then Bulk build will try to create a Maze-
Phrase for each maze, and it will use that regular phrase for every bulk maze, unless you have entered 
some "Bulk Maze-Phrases”. 

As mentioned above, if a puzzle cannot be built, then an error text file will be exported in its place 
(with its filename containing an …_Err.txt” ending.) 

If you are making Maze-Phrases and also have “Maze-Phrase:Exact-Fill” turned on or random maze 
size turned on, it is possible that during the bulk operation it will design a maze that cannot place the 
Maze-Phrase successfully, and it would fail.  If you want it to continue so you can get a as many good 
mazes as you can, simply turn on the “Contine building if errors occur” checkbox under the “How 
Many” tab.  It will try creating each Maze-Phrase design with as many variations as you have set it to. 

If you plan on doing multiple bulk-build runs, you may want to do some initial preparation to 
streamline your workflow. This can be done by choosing where the exported files get written.  For 
example, you may want to either (1) have all your bulk projects go to a single directory, or (2) you may 
want to have each bulk project go to its own separate directory.  For more instructions on how to set up 
either of these two workflow styles, please read the following two sections below. 

If you turn on the “Random Start/End” positions, it will usually put the start and end markers on 
opposite corners of the maze, or sometimes half-way down near the middle.  But it always will put 
them along an edge.  Occasionally it might put them close to each other.  It is up to you to discard any 
generated mazes that are just plain silly.  Fate is guaranteed to be random and thus seemingly cruel. 

Save a Default Bulk Setting for All Future New Mazes (Pro Feature) 
The Pro version of this software allows you to automatically generate a large number of puzzles 
instantly.  If you want most of the bulk settings to be identical when you use the bulk feature, then here 
is what you do. 

First, open a new puzzle document. Set it up with all the settings you want to use.  Then, open the bulk 
window and update each of its tabbed settings the way you want them to appear.  Make sure to choose 
the export tab. Then, choose an export format, size, and destination directory. 
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Now tap the “Save Settings as Default” button at the bottom of the bulk window.  Then choose “Save 
Current Settings as Default" from the Minos Maze Maker Pro main menu.  From now on, all your new 
documents will be created with all the bulk settings just as you set them here. 

You can make changes to this “default set” by opening a new puzzle document. Open the bulk window, 
and make any changes you want before choosing“Save Current Settings as Default" from the Minos 
Maze Maker Pro main menu again. 

Save Different Bulk Settings for Each Bulk Run (Pro Feature) 
The Pro version of this software allows you to automatically generate a large number of puzzles all at 
once.  However, you may want to set up different bulk settings for different projects.  For example, you 
may have five “beginner”  books to make, and five “advanced” books to make.  You want to set up a 
“beginner” bulk setting for those first five books, and a separate “advanced” setting for the other five 
books.  Here is how you can do this. 

First, open a new maze window, setting it up with all the settings you want to start with for the 
“beginner” books.  Then open the bulk window. Continue to update each of the tabbed bulk settings the 
way you want for those “beginner” books.  Choose the export tab; then, choose a format, size, and 
destination directory. 

Next, save all these settings in this “beginner” maze document.  Tap “Close” on the bulk window. 
Then, choose “Save…” from Minos Maze Maker's File menu and type in a name for this beginner 
“template” maze document.  For example, you may want to call it “Template-Beginner.”  You may also 
want to create a “Maze Templates” directory to save all these template files together.  Note that this is 
simply a regular Minos Maze Maker document containing all your saved puzzle and bulk settings 
within it. 

Now do all the same steps above to create an “advanced” settings template document. Although, 
change the puzzle and bulk settings to these new “advanced” settings before saving it. 

Now you have two saved Minos Maze Maker documents, each with its own saved settings. You can 
open these at any time and start a bulk build to create all the mazes for that template. 

You are now ready to start building!  To work on one bulk-build run with all its settings in place, 
simply open the appropriate “settings template document” you made earlier. Then, open the bulk 
window and start the bulk run. 

When the bulk run completes, you can open a different template document . Open its bulk window, and 3

start its bulk run. It will use its own settings to build the mazes. 

Upon completing the bulk operations, you can close the template windows. 

￼  Although you can open two windows and run two bulk operations at the same time, I don’t recommend more than 3
two at a time. Each running bulk operation gives your computer quite a workout.
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Important: Running a bulk operation on an opened document will automatically update a lot of 
the document’s settings. Overall it changes the document’s shape, size, difficulty, and solution 
layout for each puzzle.  If you want to keep the template document settings as they originally 
were, make sure to close these documents without saving any changes. 
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Use Puzzle-Macros in Text (Full & Pro Feature) 
You might want to have the title or Maze-Phrase text of your maze automatically update with 
information about the puzzle itself, a puzzle counter, or the current date, without you updating it each 
time.  For example if you create monthly puzzles, you might want to show the name of the current 
month and the name of the puzzle shape in the title.  You can do this by adding a specially formatted 
puzzle-macro  in the text field, and when the puzzle is created and printed or exported, the puzzle-4

macro will be replaced with the actual text it refers to. 

Here is an example of a few puzzles with their titles automatically updated for each puzzle. 

You can achieve this by adding the puzzle-macros $$shape and $$thismonth into the text where you 
want the shape and current month name to show.  Then, when each puzzle is created, the puzzle-macros 
will be replaced by their current real value in-place.  The Preview area will immediately display the 
filled-in title and subtitle as you type them.  To get the title results shown above, you would type your 
title like this: 

The text fields that allow puzzle-macros are the Title and Maze-Phrase text fields. 

Puzzle-macros must start with $$ and must be all-lower-case.  If you misspell a puzzle-macro, then it 
will be left unchanged.  After you complete the typing of a puzzle-macro in a text field, it will 

 In other software applications these are sometimes also called “parameters” or”variables” or “placeholders”.4
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automatically be shown (in its expanded form) in the Preview area.  The list of all puzzle-macros along 
with a description of each is below: 

• $$shape - This will insert the name of the shape for this puzzle (from the shape menu.) 

• $$dimension - This will insert the number of letters wide for this puzzle, e.g., “16”.  This will always 
be a single Arabic number. 

• $$dimxy - This will insert the number of letters wide and tall for this puzzle, e.g. “16x16”. These 
will always be Arabic numbers. 

• $$exportcounter - This will insert the current “Export counter”, which will begin numbering with 
the “Export Counter starting” value you choose in the Export dialog, and will increase with each 
puzzle you export.  This can be used to add a “puzzle #” in your puzzle titles, which will correspond 
with the number in the exported file names of each puzzle.  For more information on using the 
Export Counter, see this section link. 

• $$datetoday - This will insert today’s full date (year, month, and day), based upon your local 
country’s region setting on your computer. 

• $$thisyear - This will insert the current 4-digit year, formatted according to your computer’s locale 
setting. 

• $$thismonth - This will insert the full name of the current month, formatted according to your 
computer’s locale setting. 

• $$thisweekday - This will insert the name of this day of the week, formatted according to your 
computer’s locale setting. 

• $$nextmonth - This will insert the full name of the month following this month, formatted according 
to your computer’s locale setting.  This could be useful if you always make a maze ahead of time to 
publish the following month. 

• $$nextweekday - This will insert the full name of the day of the week for tomorrow, formatted 
according to your computer’s locale setting.  This could be useful if you always make a maze ahead 
of time to publish the following day. 

The following puzzle-macros are available in Minos Maze Maker Pro for the #title commands and 
Maze-Phrase text, when using the Bulk-Builder feature: 

• $$designcounter - This will insert the current Bulk-Builder design counter, as a value starting at 1 
and increasing for each puzzle design to the total number of puzzle designs you wanted to create.  
This is the overall bulk-created puzzle number. 

• $$variationcounter - This will insert the current Bulk-Builder design variation counter, as a letter 
value starting at 'a' and increasing for each variation of the current puzzle design.  If you choose not 
to have any variations (by setting “number of variations…” to 1), then this puzzle-macro will be 
empty. 
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Upgrade to Get the Pro Features 
Run Minos Maze Maker, and find the “Minos Maze Maker” application menu at the top left of your 
screen. Open the menu and select “Pro Upgrade…”.  This menu item lets you immediately get all the 
extra features available in the Professional (Pro) version of this software via a one-time in-app 
purchase. 

Simply tap the button “Upgrade 
for $—” to begin the upgrade.  If 
you have already purchased the 
Pro upgrade on a different 
computer and don’t yet have the 
upgrade license on this computer, 
you can easily use this dialog to 
“restore” your Pro purchase onto 
this computer as well.  In that 
case, simply tap the “Restore 
Purchase” button instead.  Once 
you have upgraded to Pro, you 
will be able to receive all future 
Pro updates. You will also receive  new full and pro features for free, forever. 

You will be asked to log into the Apple App Store with your Apple ID, which you used to purchase 
software. Then, you will be able to upgrade or restore it. 

___________________________ 
Minos Maze Maker - User Guide Page ￼  of ￼30 66

_________________________ 
Copyright 2025, SchwanSongs

http://www.schwansongs.com


After upgrading, you will need to quit and re-start the software. This allow Minos Maze Maker to start 
up with the Pro features. 

After that, all the Pro features available will be available to you (bigger mazes, bulk-builder, user-
designed shapes, alpha-numeric shapes, more export styles, etc.) 

Get a Commercial License to Sell Mazes in Your Own Books/Products 
I have good news!  You do not need any commercial license to sell any of your puzzles created with 
my software! All exported mazes and solutions are copyright-free and royalty-free without any 
requirement for you to obtain a commercial-use license.  You are explicitly allowed to give away or sell 
all the puzzles you create with my software.  Moreover, you can use the exported information to 
generate your own games from them. I do not require you to fill out any kind of license, ever!  Of 
course, if you still want to offer me something, please see the next item! 

Add Minos Maze Software Credits to Your Own Product 
I have good news!  You do not need to credit my software in your own publications or software that 
use the puzzles.  At the same time, I would certainly appreciate it if you do mention it. After all, doing 
so will help advertise my own products, which allows me to work on even more features and other 
software products for you. 

Many people like to read honest reviews about products before getting them. So, I would encourage 
you to write and publish a review of my software on Apple’s App store, or your own newsletter, or on 
your YouTube channel.  Here is a suggestion for a “credits line” that you could add somewhere in your 
newsletter, book, or web/software product: 

These mazes were designed with Minos Maze Maker by SchwanSongs: www.schwansongs.com 

Print this User Guide to a Printer 
Here is how you would print a copy of this user guide, instead of viewing it on-screen. 
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First, open the user guide window by choosing “Minos Maze Maker * User Guide” from the “Help” 
menu.  With the user guide window displaying, choose“Print” from the “File” menu. It will print the 
entire user guide to your printer. 

You can also download the full PDF file of this file directly from the button at the top of the user guide 
window, or from the software product page of my web site.  Then, you can easily read it elsewhere 
“offline.” 

Find the Hidden “Easter Egg” Features 
Why would you think there are extra features hidden in my software?  Who told you?  I have 
absolutely no idea what you are talking about.  I don’t believe  there are secret passages that let you 5

unlock extra features.  Of course if they did exist, I am sure you would be 
alerted by some kind of “Bat-signal" at the top of the window. 

OK, since you have patiently read thus far, one little secret will out.  To 
print or export a maze grid that has not been built yet, simply hold down the <Option> key while 
opening the File menu.  This will force the Print and Export menu items to be allowed even if there is 
no maze built yet.  You can now create “template” images that are not yet “eaten” with maze paths.  
Perhaps useful for creating templates or playing boards for other purposes. 

Contact the Author with a Feature Request or Bug Report 
If you found something that isn’t working correctly, or if you wish that this software did something 
differently, or you would like a new feature added, I would certainly like to know.  I am constantly 
adding these to my to-do list from my users and testers. Likewise, I always strive to update my 
software so that it does what you want.  You can even write just to let me know that it is working well 
and you are enjoying it! 

The best way to contact me is to run the software and choose “Contact Author” from the Help menu.  
This will open your e-mail software and automatically create an e-mail to me.  This also adds the 
version of the software you are currently using at the bottom of the e-mail, which can be helpful to me 
when answering your questions. 

Send any feedback or correspondence to me at: note@schwansongs.com, or via the “Contact” link 
on my web site at: www.schwansongs.com 

 There is a subtle but critical difference between belief and knowledge.5
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5. Details: What Does This Thing Do? 
This section offers more detailed descriptions of each tabs and their individual options.  You can also 
hover your mouse over different options and menus to activate a “tool-tip” text box that will give you 
additional information about each item. 

Note: Some of the features described here are only available in the Full or Pro version, not the 
“Lite” version. 

Main Document Window 
When you start Minos Maze Maker, it opens a new “document window.”  Configure your mazes by 
using the settings located on the left-hand side, and looking to the right-hand side for the maze preview 
area.  The preview displays the updated puzzle as you design it.  Some buttons along the bottom offer 
you quick access to building, printing, or exporting your maze.  These button commands can also be 
started by main menu items or their keyboard shortcuts. 
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This new window can be saved as a document (e.g. file) on your computer. Later, it can be opened (just 
as you do with word processor documents) to show the maze and all its settings, saved just as you left 
them. 

Minos Maze Maker allows you to create and open multiple windows at once; although, you will likely 
just open and work with one at a time. 

Maze Settings Tabs on the Left 
You can use many settings to customize and create unique looking mazes.  They are grouped into sets 
of “tabs” along the upper left side of the document window.  First, there are the “main” tabs along the 
top. When you choose one of those top tabs, there are often additional “secondary” tabs underneath.  
All of these tab settings are described below. 
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Layout: Title Tab 
The “Title” tab is where you choose the title to print above your puzzle. It appears on the printed pages, 
and optionally on the exported puzzle files.  This field is optional and can be left blank if you want no 
title text displayed. 

Layout: Title: Maze Title 
Title: You can enter text in the title field and that text is then printed at the top of your printed puzzle 
pages.  You can also leave the field blank, since it is optional.  If you type in title text that is too long, 
the text will wrap to a second line at the edge of the page when it is printed. 

Note: If you want to refer to the current date or the current puzzle number or puzzle shape/size 
in your title, e.g. “Heart Puzzle #3 for Monday”, you can add magic “puzzle macro strings” in 
the title and subtitle fields, and they will get automatically filled in for you as you print or 
export.  See the “Puzzle Macros” section for more information. 

Color: The color of the title text. 

Font: The font to use for the title text. 

Display title on: You can choose whether the title appears on the puzzle page, the solution page, or 
both.  This will affect both the printed pages and exported mazes (if you turn on "including title..." 
checkbox in the Export window.) 
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Layout: Maze Tab 
This tab has settings that let you control the size and shape of the overall maze. 

Layout: Maze: Maze Size 
Size: Adjust this slider to choose the overall width and height (in “cells”) of the maze.  The larger the 
number, the more complicated the maze becomes, and the longer it takes to generate it.  Increasing the 
size also makes the custom maze shapes look nicer and less jagged.  If you are printing the maze to a 
printer, then as you increase the maze size, the cell size will shrink so that the overall maze will always 
fit on a single page.  If you export the maze files instead of printing them, you can then set a separate 
“output” pixel size for the maze, for high quality large-format images; See the “Export Maze: File 
Size…” section linked here. 

Short Side Size: This slider appears when you choose a shape of either rectangle tall or rectangle wide. 
It lets you choose the short(er) side size, i.e., the number of cells along the shorter side of the rectangle. 
The larger the number, the closer to a square it becomes. It ignores anything larger than the current 
maze size. Changing this allows you to fine-tune the rectangle puzzle to fit either a tall, thin column or 
a wide, thin row. 

Note: Unlike other shapes, once you choose one of the Rectangle shapes you can then make the 
“Puzzle Size” smaller than ten, in case you want to make “five by nine” rectangular puzzles, for 
example. 
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Layout: Maze: Maze Shape 
You can choose from many different shapes to use.  However, the shapes only become available if you 
have a maze size that is ten or bigger. Any puzzles smaller than this must be square. 

Geometric: This lets you choose from a variety of preset shapes for the maze.  Here are the available 
geometric shapes. 

Alpha-Numeric: (Pro Feature) This lets you choose from the uppercase letters A through Z, and the 
numeric digits zero through nine. 

Font: (Pro Feature) You can choose from a variety of fonts to shape the alpha-numeric characters. 

Design your own: (Pro Feature) This lets you design your own shapes.  A built-in “shape editor” 
allows you to design a logo or complex shape of your own. You can then use that to create your puzzle.  
You can also export your shape to send to others, or import shapes designed by other software users.    
See the “Design your own shape” section linked here. 

Note: When you choose one of these non-square shapes, there are not as many available cells in 
the maze.  If you have long Maze-Phrases, they may not fit in these other shapes.  To 
compensate for this and still fit in your words, you will need to increase the maze size.  
Furthermore, many of these shapes will look nicer & smoother at larger maze sizes. 
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Layout: Cell Tab 
This tab has settings that let you choose from different maze cell shapes, and whether to fill the maze 
cell “floor” with a solid color, or leave it transparent. 

Cell shape: This lets you choose from a number of cell shapes for the maze. 

Note: Regular square-cell mazes are usually referred to as “Orthogonal.”  Hexagon-cell mazes 
are called “Sigma”, and triangle-cell mazes are called “Delta.” 

Add solid cell floor color: Turn this checkbox on to “paint” each cell with a particular solid floor 
color.  Turning this off leaves the cells transparent. 

Color: When the above checkbox is on, you can tap the color box to change the cell floor color. 

Cell Labels (Minos Melee Maps) 
This tab section allows you to turn on unique numeric labels for each cell of the maze.  In this way, 
each cell has its own unique sequential number.  You can print this maze out and use it for your own 
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role-playing board game, where you might roll dice to determine where your players or monsters or 
treasures are scattered within a maze, and then take turns trying to find your party and escape the maze.  
Or invent your own brand new game or puzzle that relies on referring to cell positions and knowing the 
distance from the beginning or end of the maze. 

This feature is probably best-used when you also choose the wall style of “all walls+path” so that your 
players can easily see the paths on the puzzle page, and you (the D.M.) can also see the overlaid 
solution path on the solution page, along with distance values on each cell, telling you how many 
moves to the exit (and back to the entrance.) 

Display Cell Labels: Turn this on to print cell label information inside each cell. 

Cell Label Format: Choose how the cell labels should be formatted, either as indeces (cells labeled 
1,2,3… consecutively) or as x,y coordinates. 

Display Start:End Distances on Solution Cells: Turn this on to add numbers inside each cell (only on 
the solution page) that indicate (a) distance between this cell and the start cell, and (b) distance between 
this cell and the end cell.  These numbers can be useful in determining how many player turns it will 
take to get from this spot to the end, and also whether the player is going in the correct direction. 
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Cell Label Text Color: Choose the color to draw the cell label text. 

Font: Choose the font to draw the cell label text. 

Puzzle Cell Label Size: Choose the relative size to draw the cell label text on the puzzle. 

Solution Cell Label Size: Choose the relative size to draw the cell label text on the solution. 
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Layout: Wall Tab 
This tab has settings that let you adjust how the walls are drawn, color, width, squiggly-or-straight.  
You can instead choose to draw the paths between the walls, or both walls and paths. 

Layout: Wall: Wall/Path style 
Change how the maze walls are drawn.  Mazes can be drawn with combinations of outer walls, inner 
walls, and an inner line tracing all the paths: 

Layout: Wall: Outer Wall 
Line width & color: Change the outer wall line thickness and its line color. 

Layout: Wall: Inner Wall 
Line width & color: Change the inner wall line thickness and its line color. 
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Layout: Wall: Line Wiggliness 
Wiggliness: How much to “crinkle” the lines of the walls and paths.  Setting this to 0 will leave walls 
completely straight.  Increasing the wiggliness will break the wall into little pieces and make them twist 
more and more. Small values can give the maze a “hand-drawn”  look.  Large values can add to the 
difficulty level of following along the path.  As you increase the number of cells of the maze, the 
wiggliness is slightly reduced (and number of broken wall segments is reduced) to keep them from 
getting too crazy-wiggly and completely cutting off a passage. 

Wiggle Outer Walls Too: Turn this on to apply the wiggliness to the outer walls as well as the inner 
ones.  Sometimes you will want the outer “outline” of the maze to not be wiggly, but the inner walls to 
be wiggly.  This allows you to control that.  If you turn on "Wiggle Outer Walls Too", then you will 
notice the overall maze will shrink slightly to allow the outer walls more room to squiggle outside the 
lines and not get cut off by the bounding area. 

Layout: Wall: Path 
Path Width: If you have chosen to draw the maze as a path, then the width of its line can be chosen 
here.  As you change its width, you can see the result in the (Solution) preview area.  If no maze has 
been built yet, the path width and color will be shown as a placeholder dot in each cell. 

Path color on puzzle: Change the line color of the path on the puzzle. 

Path color on solution: Change the line color of the path on the solution key.  It can be helpful to 
change the solution key’s path color to something else (perhaps a light gray) so that the solution path 
can stand out. 
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Layout: Start/End Tab 
This tab has settings that let you set whether there are markers shown for the start and end points of the 
maze, and what they should look like. 

Layout: Start/End: Start & End Markers 
Show the Start/End markers as: Change how the start and end markers are displayed in the maze. 

• “Do Not Show” will hide the start and end markers completely.  Note that this will also extend the 
Solution Markers (mentioned next) to fill in those start and end cells. 

Note: If you turn off these markers, they will still be very lightly shown in the Preview area, so 
you can drag them to new positions. 

• “Start&End Letters” will print an “S” at the start and an “E” at the end, or whatever letters you 
choose under “Start Letter” and “End Letter” below.  They can each be one or two characters long. 

• “Arrows” will display a solid arrow for the start and end markers, with the Start Marker pointing in, 
and the End Marker pointing out.  The “style” of the arrow drawn can be changed, by choosing a 
different arrow style under the “Solution” tab.  Note that if a Start or End Markers is completely 
within the maze (i.e. not next to an outer wall) then the Marker will displayed as a “Circle Dot” 
instead.  Also note that the Start arrow will point in a generic “in” direction away from the opening, 
not necessarily toward the correct path to start on. 

• “Circle Dots” will display a solid colored circle for the start and end markers. 
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• “Cell-Shaped Dots” will display a solid colored inset cell shape for the start and end markers. 

Examples of these Start/End marker settings are shown below: 

Start color: Choose a color for the “Start” marker if shown. 

End color: Choose a color for the “End” marker if shown. 

Start letter: If you have chosen “Start&End Letters” for the markers, then here you can choose a letter 
for the “Start” marker.  Note that this character can be Unicode in any language/alphabet, even emoji. 

End letter: If you have chosen “Start&End Letters” for the markers, then here you can choose a letter 
for the “End” marker.  Note that this character can be Unicode in any language/alphabet, even emoji. 

Letter font: If you have chosen “Start&End Letters” for the markers, then here you can choose the 
letter font to use for those letters. 

Start/End Marker Size: Slightly increase or decrease the overall size of the start and end markers. 

Open Outer Walls at Start/End: When checked, this opens the outer wall where the start and end 
markers are, if they are against outer walls.  If un-checked, then the outer wall will remain closed, 
completely enclosing the maze shape.  This option was suggested to prevent precocious people from 
drawing a simple line around the outside of the maze from the start to the end and claiming that they 
followed the instructions. 

Start Cell Wall Opening: Tapping this button lets you cycle through all possible outer wall directions 
to break open for the Start cell.  If the cell is completely inside the maze with no exterior (edge) wall, 
this button will be disabled. 

End Cell Wall Opening: Tapping this button lets you cycle through all possible outer wall directions 
to break open for the End cell.  If the cell is completely inside the maze with no exterior (edge) wall, 
this button will be disabled. 
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Layout: Solution Tab 
This tab has settings that let you set the style and size of the solution path markers. 

Layout: Solution: Solution Markers 
Show maze solution path as: Change how the solution markers are displayed in the maze. 

• “Do Not Show” will hide the solution markers completely. 

• “Circle Dots” will display a solid colored circle in each cell between the start and end markers. 

• “Cell-Shaped Dots” will display a solid colored inset cell shape in each cell between the start and end 
markers. 

• “Line” will display a continuously connected line through each cell between the start and end 
markers. 

• “Arrows” will display a small arrow-pointer shape in each cell between the start and end markers, 
pointing from the start marker toward the end marker.  See “Show arrows as” below to see how to 
choose different arrow styles. 

• “Maze-Phrase…” options will be available if you are creating a Maze-Phrase.  See the “Maze-Phrase 
Tab” section linked here for more information. 

Examples of different solution markers are shown below: 
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Show arrows as: When you have chosen “Arrows” as the “Show maze solution path”option above, 
you can alter the style of the arrows as Thick or Thin, Flat or Pointy.  This arrow style will be used for 
the Start/End marker arrows too. 

￼  

Solution path color: Choose a color for the solution markers if shown. 

Solution path marker size: Slightly increase or decrease the overall size of the solution path markers. 

Thick Flat Thick Pointy Thin Flat Thin Pointy
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Difficulty Tab 
This tab lets you set how difficult the maze is to solve.  You simply move the slider from easy to hard 
and re-build the maze. 

Difficulty 
Maze Difficulty: This slider changes many aspects of the maze using a single value, from one through 
eleven.  In general, one will be a much easier maze to solve, six will be moderately difficult, and eleven 
will be very difficult to solve.  Here are some examples of the same maze built with different difficulty 
settings.  You can see that easy mazes have longer straighter  paths, and a shorter run from start to end. 

Under the difficulty slider is a list of some of the internal settings that are updated as you change the 
difficulty.  These are informational, and probably not very interesting. 

Desired Solution Length: This determines whether the software looks for and chooses from the 
shortest, shorter, longer, or longest possible paths for the solution path. 

Steps before Turn: How long should a straight path try to go before changing direction. 

Branch Length: How long (# of cells) should each dead-end path run. 

Steps before Branch: How long should a path go before branching to multiple directions. 

Number of Seeds: How many “magic maze-bushes” are planted in the grid.  Don’t ask. These are not 
the droids you are looking for.  You can go about your business. 
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Maze-Phrase Tab 
This tab has settings that let you enter a text 
phrase , which Minos Maze Maker will then 6

lay out, letter-by-letter, along the solution 
path from start to end.  It will fill the rest of 
the maze with letters from your phrase, but 
only the solution path will contain the entire 
correct phrase.  All other dead-end branches 
will have incorrect (slightly scrambled) 
versions of the phrase.  As you increase the 
difficulty setting, the "scrambling" happens 
later along the dead-end phrases. 

Normally the phrase will spread the letters 
out along the solution path, but you also have 
the additional option to fill every cell of the 
maze with a letter (“Exact-Fill” described 
below.) 

The first and last letters of the phrase will 
land exactly on the start and end cells, and 
all the letters in between will be spaced out 
evenly between along the paths.  If you 
choose to also show the Stard/End markers, 
then the Maze-Phrase will start and end one 
cell inside the markers, to allow spots for the 
Stard/End markers to show. 

If the phrase is too long or short and a solution cannot be found, then an error message will display and 
help explaining how to adjust things to try again.  You can make a minor change and re-build the maze 
until it fits, since a different solution path 
(and length) is created each time. 

For even more information on how to build 
one of these specialized "Maze-Phrase" 
puzzles, see the “Make a Maze-Phrase 
puzzle” section linked here. 

Maze-Phrase 
Type your Maze-Phrase here: A line of text to lay out across the solution path.  You may enter any 
text (in any language), and all letters and punctuation will be used.  However, space characters will be 
removed along the path.  The phrase must be at least three letters long, and must be no longer than the 

 This is an optional variation of maze-making, and if you leave the phrase empty, a regular maze will be created.6
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maximum number of cells/steps possible for the solution of the maze (which depends on maze size, 
shape, and difficulty settings.)  It cannot be a string of the identical letters and at least some letters must 
be unique.  If you leave the phrase completely empty, then the Maze-Phrase feature will be “turned 
off”, and a regular maze (with no letters inside) will be created instead. 

Note also that when you start typing letters in the Maze-Phrase 
text box, a little tag will show up under the Preview Window, 
telling you that “Maze-Phrase” mode is on.  Also, the number of 
letters used for the Maze-Phrase (ignoring spaces) is shown in the 
upper right above the Maze-Phrase text box, and will update as 
you type. 

Copy as Template String: Tap to copy a string to the clipboard that is your Maze-Phrase, but with all 
its alphabetic and numeric letters replaced with underscores.  This can then be used as a printed 
“template” or “placeholder” below your maze, for your users to fill in the letters as they find them.  For 
example, here is a Maze-Phrase, and below it is the template that would be copied for it: 

Beware the Jabberwock, my son! 

ˍˍˍˍˍˍ ˍˍˍ ˍˍˍˍˍˍˍˍˍˍ, ˍˍ ˍˍˍ! 

You can also change the template string to include a space character between each template letter to 
“space it out” a little more and be more readable.  See the setting “Add spaces between template 
underscore letters” below. 

Letter color: Set the color to use for the Maze-Phrase letters in the puzzle. 

Letter font size: Change the size of the letters within the cells of the puzzle.  This will affect the letter 
size in the puzzle and the solution.  This means that when you have created a Maze-Phrase, the 
“Solution Path Marker Size” under the Layout:Solution tab will have no effect on the solution font size. 

Font: Choose the font to use for the Maze-Phrase letters in the puzzle.  Note that if you are using non-
Latin alphabets, you need to choose a font that supports those letters, because some Macintosh fonts do 
not contain letters for other alphabets.  ざねんですね！ 

Letter baseline adjustment: Move the letters up or down a little bit inside the maze cell, so they look 
vertically centered.  Some fonts may look better if their letters are moved up or down a little. 

Change letter case to: Choose whether you want to (1) leave all the letters in the same case 
(capitalization) that you entered them, or (2) change them to all lower case, or (3) change them to all 
upper case. 

Find an “Exact-Fill” solution: Turn this off to space out your phrase letters so that they stretch exactly 
from start to end, no matter how large or difficult your maze is.  This also spaces out the other random 
letters sprinkled through the maze to give a balanced look to the maze.  As long as the maze is large 
enough to fit the phrase along the solution, it will succeed. Turn this on to find a solution that is exactly 
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the same number of cells as the phrase itself.  This will also create a maze where every maze cell will 

be filled with a letter of the phrase. 

Note that with this setting on, you will have to more carefully match and “fine-tune” your Maze-Phrase 
length to a maze size/shape/difficulty setting to get the maze to successfully build.  Although the 
software will try very hard to find the exact solution for you, this setting will require you to do some 
trial and error adjustment to get it to build an Exact-Fill maze.  If it cannot, the error message will give 
you an idea of how far off you are, and you can either try again a few times, or alter some maze settings 
and try again. 

Display Maze-Phrase prompt on printed page as: Choose to show a hint to readers to look for the 
Maze-Phrase on the puzzle page.  It can be omitted, or have a prompt and template or Maze-Phrase 
text. 

Add spaces between template underscore letters: Turn this on to add space characters between every 
template underscore letter, to help separate the letter spots.  If off, then the template will exactly match 
the number of letters of your Maze-Phrase, and the displayed underscores will be “shortened” so they 
don’t run together like normal underscores do. 

Maze-Phrase Solution Options 
When you have created a Maze-Phrase, there are some extra options available for how to display the 
solution: 

Maze-Phrase Letters (Sparse): The solution will be printed with letters along the solution path, and 
the rest of the maze will be empty. 

Maze-Phrase Letters (Dimmed): The solution will be printed with all the letters shown in the maze, 
and the letters along the solution path will be the “Solution Color” you chose, and all the non-solution 
letters will be dimmed as a light gray. 

Maze-Phrase Letters & Line: The solution will be printed with all the letters shown in the maze, and 
the letters along the solution path will be the “Solution Color” you chose, and all the non-solution 
letters will be dimmed as a light gray.  In addition, the solution path will be drawn as a solid line 
underneath the solution letters.  You can adjust the width of the solution line and its color, just like you 
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would for a regular maze solution line.  See the “Layout: Solution: Solution Markers” section linked 
here. 
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Printing Tab 
This tab has settings that let you set which maze pages should be printed. 

Printed Pages 
Which pages to print: Choose what parts of the puzzle to print: Puzzle Page only, Solution Page only, 
or both Puzzle and Solution Pages.  Choosing this option only affects what is printed to a printer via the 
File:Print menu item, not exporting the maze to files. 

Print the page footer line with logo: Turn on/off printing of the software name and company logo at 
the bottom of each page. 
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Stats Tab 
This tab displays a number of detailed statistics about the generated maze.  If no maze is generated, this 
table is empty.  Depending on the kind of maze you create, different statistics will show up here.  This 
is rather technical geeky information for most users, so feel free to ignore it. 

Perhaps the most interesting line is “Solution Length as % of Total Maze Cells”, which tells you how 
long the solution path is, compared to the overall size of the maze.  That is, it tells you how much of the 
maze you have to wander around before you get to the exit. 
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Maze Preview on the Right 
The pane on the right half of the window displays a preview of what your maze and solution look like.  
When you change the size or shape of the maze, its new shape and size will be instantly reflected here.  
After you build a maze, the final maze puzzle and its solution will be displayed here as well. 

There are radio buttons at the top for you to preview either the Puzzle or its Solution.  You can also see 
and drag the start/end markers around in the preview area. 
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More goodies for you! Button 
This button opens a window that displays a list of many of my other software products and published 
books, with a short description of each.  Simply tap one of the product rows, and it will immediately 
open your web browser to a page that fully describes that product, and where to get it. 

Help (User Guide) Button 
The circled-question-mark button is a “Help” button, and opens a window with this user guide 
displayed for quick access.  It is the same as choosing “User Guide” from the Help menu. 

Export Button 
After building the maze, you can immediately export the maze by tapping the “Export” button in the 
lower-right corner of the document window.  You can also choose “Export Maze” from the File menu, 
or press ⌘-1.  This will bring up an export dialog, letting you choose the destination directory and a 
number of other options.  See the “Save/Export” section linked here for more information. 

Print Button 
After building the maze, you can immediately print the maze by tapping the “Print” button in the 
lower-right corner of the document window.  You can also choose “Print” from the File menu, or press 
⌘-P.  This will bring up the standard print dialog, letting you choose the printer, page layout, number 
of copies, etc. 

Note that before you print the pages, you can configure what to print and how the page looks, for 
example, the page title, footers, and whether to print the maze page or the solution page (or both).  You 
can do this from settings under the main window’s “Layout” tabs, described above. 
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Build Button 
After configuring the maze, you can tell the software to build a maze by pressing the “Build” button in 
the lower-right corner of the document window.  You can also choose the “Build the Maze” item on the 
Action menu, or press ⌘-B. 

Once the maze begins building, a progress sheet will display, showing the progress of laying out the 
maze.  This could take from a few seconds to a minute or two, depending on how large or complex the 
maze is.  If you want to stop the building of the maze, simply press the “Cancel” button on the sheet, 
and the maze will stop building and be cleared. 

If you don’t like the final solution path for the currently built maze, simply press the Build button 
again.  Each time you press it, the maze will be re-built with a completely different solution path. 

Easter Egg Note: If you have a large maze (40x40 or bigger) and you have the Difficulty level 
set to very high, Minos will sometimes get a bit of ennui and just not build that really long 
twisty solution you want it to.  You can force it to take even more time finding a solution by 
holding down the <Option> key as it nears the end of the progress bar.  As long as you hold the 
key down, it will continue checking every possible path for the longest.  As soon as it has found 
all possibilities, or when you release the key, it will immediately stop and use the best path it 
found so far. 
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Menus at the Top 
The menu items along the top "menu bar" contain special commands for opening/closing/printing your 
documents, etc.  You won’t need to use them too often, but the menu items that are specific to Minos 
Maze Maker are explained here. 

Minos Maze Maker menu 

Minos - About Minos Maze Maker 
Choose this item to display a window that gives credit to all the people who helped make this software 
happen, accompanied by some fun parade music as they scroll by and wave. 

Minos - Settings  7

Choose this item to open a window that lets you change application-specific settings. When you set the 
values here, they are used for all future runs of Minos Maze Maker. See the “Settings window” section 
linked here for more information. 

Minos - Save Document Settings as Defaults 
Choose this item to take and save a "snapshot" of the current document's settings (including maze size 
& shape, difficulty, fonts/colors, etc.)  Afterward, all new documents you create with Minos Maze 
Maker will start with these default settings. 

Minos - Reset Document Settings to Saved Defaults 
Choose this item to reset all the current document's settings to the prior saved document settings, i.e., 
the settings you saved when you chose the menu item above, “Save Document Settings as Defaults”. 

Note: This only resets the currently open document settings, and does not change the settings for 
future newly opened documents.  To also use these settings for all future new documents, 
immediately select the “Save document Settings as Defaults” menu item after selecting this 
menu item. 

Minos - Reset Document Settings to Factory Defaults 
Choose this item to reset all the current document's settings to the original factory default settings. 

 Note that “Settings” used to be called “Preferences”, and Apple changed this name (in MacOS 13/ Ventura) to 7

“Settings” to align with iPhones, because, well, you know, “a foolish consistency is the hobgoblin of small minds.”
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Note: This only resets the currently open document settings, and does not change the settings for 
future newly opened documents.  To also use these settings for all future new documents, 
immediately select the “Save document Settings as Defaults” menu item after selecting this 
menu item. 

Minos - Change All Colors to B&W 
Choose this setting if you are printing a book or worksheet, It will quickly change all font/grid colors to 
black and white (and gray).  To then save this as the default setting for all future newly-opened 
documents, choose “Save as default settings” described above. 

Minos - Pro Upgrade… 
This menu item allows you to purchase an in-app upgrade.  Immediately it gives you all the extra 
features available in the Professional (Pro) version of this software.  For details, see the “Upgrade to 
get the Pro Features” section linked here. 

File menu 

File - New 
Creates a new empty document window, where you can build a new maze. Save your maze document 
as a file if you want to open it later.  You can have multiple windows open at once, switching between 
each of them periodically. 

File - Open/Save 
This allows you to save an existing maze to a file (including all your settings and solution), or re-open 
it.  These files can also be sent to other Minos Maze Maker users who can open and use the maze too.  
These special files can only be opened by Minos Maze Maker. 

File - Revert to 
As you build mazes from a document, you can Save it to the current document. It will be remembered 
as a “snapshot” or “version.”  Later on, you can choose this menu item to bring up a list of saved 
versions of this document. Instantly you can restore back to one of those prior saved file versions.  Use 
this feature to “rewind” back to an earlier maze solution you might have liked best. 

File - Export Maze 
Choose a file name, and an image of the the maze (and optionally an image of the solution) will be 
converted and saved.  This item will be disabled if you have not yet built a maze.  You can export just 
the Puzzle image, or both the Puzzle and Solution images together.  For more details about exporting, 
see the “Save/Export” section lnked here. 
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File - Print 
This opens the print dialog and allows you to print one or more copies of your maze page (and solution 
page) to a printer.  This does the same thing as the Print button on the main window. 

Note: This option will format and print your maze along with your title and any Maze-Phrase 
solution key underneath on the solution page. 

Edit menu 
Nothing special here… these are standard system text editing copy/paste items. 

Action menu 

Action - Build Maze 
Choose this to build a maze from the settings you have chosen.  This menu item is equivalent to 
tapping the "Build" button on the main window. 

Action - Shape Editor (Pro Feature) 
Design your own custom shapes and create puzzles with them.  See the “Design your own shape” 
section linked here. 

Action - Bulk-Builder (Pro Feature) 
Choose this to build multiple mazes from the settings you have chosen.  After you choose how many 
mazes to make and a destination directory, the puzzle and solution files will be generated together.  See 
the “Bulk builder” section linked here. 

Action - Daily Maze (Pro Feature) 
Choose this to create a new unique maze that will be different every day.  Minos Maze Maker will 
automatically select the maze type, difficulty level, digit style, and then build the puzzle for you.  It will 
create the same maze for that entire day, and a completely different one on a different day. 

And here’s the magic part; The maze for this calendar day will be identical for all Minos Maze Maker 
users anywhere around the world!  This offers all sorts of possibilites of cross-country collaboration or 
competition with your friends. 

Before Minos Maze Maker loads the new maze into your existing document — thus overwriting any 
existing maze settings you have there — it will first prompt you if it is OK to replace your current 
document with the Daily Maze.  If you tap “Yes”, it will load the Daily Maze and build it for you.  It 
also adds a title with today’s date. 
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Note: There are some options that are never chosen for Daily Mazes, for example very small or 
very large mazes, Maze-Phrases, or certain path types.  However, you can add these items back 
into the Daily Maze after it is built if you like.  In fact, here’s a tricky tip: If after you and your 
friends all created the Daily Maze, you can all make exactly the same changes and all re-build 
your mazes, and those new mazes will all still match each other. 

View menu 
Standard Apple menu… allows zooming to/from full screen. 

Window menu 
Standard Apple menu… these are standard system window-handling items, minimizing, etc. 
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Help menu 

Help - Minos Maze Maker User Guide 
This menu item opens a window that 
displays this user guide document.  
Adjust the size of the text by making 
the window larger or smaller.  Print a 
copy of this user guide by choosing 
Print from the File menu.  You can tap 
the “Save to PDF file” button to save a copy of this user guide as a separate PDF file.  You can then 
open it in a nicer PDF viewer, or copy it to another device for later viewing. 

Note: While the user guide window is open, you can tap any "table-of-contents" page number to 
jump to that page.  To search for a word or phrase in the document, enter that text in the Search 
field at the top.  You can type the <Return> key to find the next occurrances of that text. 

Help - Minos Maze Maker Introduction 
This menu displays a multi-tabbed quick introduction, illustrating some of the features of the software.  
It opens each time you run the software, unless you un-check the “Show this window on startup” box at 
the bottom of the window.  You can always open it later, by choosing this menu item. 

Help - Next User Tip 
This opens a little window with an interesting tip or suggestion for interesting things you can do with 
this software.  Each time you choose this menu item, a new tip will be displayed. 

Help - Bulk Builder - Guide 
This opens a window displaying a document showing you how to enter large lists of Maze-Phrases. 
These can be used in the Bulk Maze-Phrase tab of the Bulk-Builder in the Pro product. 

Help - ESP File Export Guide 
This menu item opens a window displaying a document explaining the special ESP File format 
available in the Export window of the Pro product.  This exported file format captures the entire puzzle 
and answer in a single easily-readable file, and can be used for advanced publishing workflows or as 
data to power your own interactive web puzzle games. 

Help - What’s New 
This menu item displays a detailed list of all the new features and bug fixes. It details what is new in 
this release.  There is also a list of known bugs, in case you find something acting strangely and want to 
see if I already know about it.  Moreover, there are notes on prior releases. 
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Help - Compare Features (Pro/Full/Lite) 
This menu item displays the feature differences between the Lite and Full and Pro versions of this 
software. 

Help - Rate/Review Minos Maze Maker 
This menu item opens an Apple App Store window. It lets you add your rating, and write a review for 
this software. By doing this, you are letting others know how you like it.  Please consider rating it and 
possibly writing a sentence or three about it. 

Help - Contact Author 
This menu item opens an e-mail. You can easily send me an update with any questions, bugs, or feature 
requests.  It automatically contains some information about which version of the software you are 
using. Having this information helps me answer questions for you. 

Help - Minos Maze Maker Product Web Page 
This menu item opens a browser window that displays the product web page for this software. 

Help - More Fun Products 
This menu item opens a window that displays a list of many of my other software products and 
published books. Each has a short description.  Simply tap one of the product rows, and it will 
immediately open your web browser to a page that fully describes that product, and where to get it. 

Help - Company Web Page 
This menu item opens a browser window that displays my company web page, showing my other 
products and myriad interests. 
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Settings Window 
This window lets you change settings that are specific to the application software. The settings here 
alter the overall look or behavior of the application itself, and do not affect your individual maze 
documents. 

Appearance Tab 
Stone texture appearance on windows: This turns on or off the stone-textured background on the 
windows. 

Show puzzle-building progress: Turn this on to watch the walls get torn down and solutions collected 
as the maze gets built step by step. This can be entertaining to watch, and gives you a peek at how my 
particular mazes are designed.  However, in order to show all the steps it slows down the maze building 
quite a bit. 

Automatically show weekly user tips: 
This will cause Minos Maze Maker, once 
a week, to open with a little window with 
an interesting tip or suggestion for things 
you can do with this software.  Each week 
a new tip will be displayed.  Turn this off 
to permanently silence the dialogs.  You 
can always manually read the next one by 
choosing “Next User Tip” from the Help 
menu. 
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Disable/Enable Tooltips: You know those useful text pop-ups that help you learn what each item is 
before you click on it by floating the text under your mouse cursor?  After using the software for 
awhile, you may want to turn those off, since they sometimes 
cover up what you are trying to look at.  Now you can!  Well, 
you can now turn most of them off… the ones on the main 
document window, the main menu, the export window and bulk-
builder window.  Simply tap the “Disable Tooltips” button, and 
(after reading the note) quit and re-start the software, and from 
now on, the tooltips will be gone.  If you want them back, simply 
repeat this process, as the button will now say “Enable Tooltips”. 

Author Info 
When you export your puzzles, you will likely want to insert your name and copyright information into 
the exported files as a way to protect/watermark your work.  Some of the export formats support this 
embedded information, specifically SVG, ESP Files, and the Text info files.  You can enter your 
information here. By doing so, it will be added to every file you export. 
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SVG Export Tab 
When you export your puzzles in “SVG” format, that file will include your specific font choice for the 
title, maze-phrase letters, cell labels, etc, as well as substitute or fall-back fonts to use in case your 
specific font choice is not available on the destination user’s computer.  Since you have no control over 
which fonts other people have on their computers, SVG can supply additional general-purpose “fall-
back” fonts. 

Here you can choose from some which will closely match your chosen font.  The font styles you 
choose here will be used for all future SVG exports.  Below is a legend showing an approximate 
example of the font styles listed in the pop-up menus above, for reference. 

Add “Fall-back” fonts to SVG text:  If you are going to import these SVG files into another 
publishing/page layout program (e.g. InDesign or Affinity Publisher) and you will then be exporting the 
final file as a PDF file, then you don’t have to worry about the SVG switching fonts on you, because 
the original fonts you chose will be used and copied exactly into the PDF file.  In this case, you should 
turn off the “Add Fall-back…” checkbox.  If you will be posting the SVG directly in a web page or 
sending it to other computers, you should turn the checkbox on. 

Below that you can choose which fall-back fonts which will closely match your chosen font for the 
title, Maze-Phrase letters, Start/End marker letters, and cell labels.  The font styles you choose here will 
be used for all future SVG exports. 

Below that is a legend showing an approximate example of the fall-back font styles listed in the pop-up 
menus above, for reference. 
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6.More Information 
This original software was written by Eduard Schwan of SchwanSongs over many years, starting in 
2013. 

The unique maze algorithm that can adjust between simple and difficult maze paths is my own 
invention, and as far as my own maze research shows, I have not found any other maze algorithms 
quite like what I have invented here.  I hope to publish a little paper on my novel maze-generating 
algorithm someday. 

The terms “Maze-Phrase” and “Minos Melee Map” are my own invented terms. 

This maze software has now grown to over 25,000 lines of Objective-C code, carefully designed, 
written and built 100% by me, and tested with the help of a small group of friends. 

___________________________ 
Minos Maze Maker - User Guide Page ￼  of ￼66 66

_________________________ 
Copyright 2025, SchwanSongs

www.SchwanSongs.com 
Bringing Software to Delight! 

http://www.SchwanSongs.com
http://www.schwansongs.com

	Introduction: What Is This Software?
	Let's Make a Maze!
	Where Is Everything?
	Main Menu Bar
	Document Window
	Maze Settings Tabs
	Preview Area
	Action Buttons
	Help: Tell Me How To…
	Make a Really Easy Maze
	Make a Really Hard Maze
	Move the Start and End Points Elsewhere
	Make a “Maze-Phrase” Puzzle
	Save a Maze Document to Disk for Later
	Save your Customized Settings for All Future Maze Documents
	Make Several Groups of Similar Mazes
	Reset your document’s settings to saved “factory defaults”
	Print the Finished Maze and Solution to the Printer
	Save/Export High Quality Maze Files for Publication
	File Size and Format
	File Naming
	Destination Directory
	Design Your Own Shape for a Puzzle (Pro Feature)
	Shape Name/Designed By
	Design & Edit Here
	Pen Size (Radius)
	Display some ruler guides
	Mouse clicks will Draw/Erase
	Fill Shape/Clear Shape
	Fill with Shape:
	Preview Here
	Puzzle Preview Display Size
	Import
	Export
	Save/Cancel
	Save
	Cancel
	Exported .ssuds Shape File Format
	Bulk Build Many Mazes at Once (Pro Feature)
	Designs
	Variations
	File Naming
	Preparing a Puzzle for Bulk Building
	How Many
	Number of Maze Designs to Build
	Number of Variations of Each Maze Design to Build
	Continue Building if Errors Occur
	Randomize Settings
	Sizes
	Shapes
	Other Settings
	Bulk Maze-Phrases
	Export Files
	Start Building Them All
	Start
	Stop
	Save Settings as Default
	Bulk Building - Additional Notes
	Save a Default Bulk Setting for All Future New Mazes (Pro Feature)
	Save Different Bulk Settings for Each Bulk Run (Pro Feature)
	Use Puzzle-Macros in Text (Full & Pro Feature)
	Upgrade to Get the Pro Features
	Get a Commercial License to Sell Mazes in Your Own Books/Products
	Add Minos Maze Software Credits to Your Own Product
	Print this User Guide to a Printer
	Find the Hidden “Easter Egg” Features
	Contact the Author with a Feature Request or Bug Report
	Details: What Does This Thing Do?
	Main Document Window
	Maze Settings Tabs on the Left
	Layout: Title Tab
	Layout: Title: Maze Title
	Layout: Maze Tab
	Layout: Maze: Maze Size
	Layout: Maze: Maze Shape
	Layout: Cell Tab
	Cell Labels (Minos Melee Maps)
	Layout: Wall Tab
	Layout: Wall: Wall/Path style
	Layout: Wall: Outer Wall
	Layout: Wall: Inner Wall
	Layout: Wall: Line Wiggliness
	Layout: Wall: Path
	Layout: Start/End Tab
	Layout: Start/End: Start & End Markers
	Layout: Solution Tab
	Layout: Solution: Solution Markers
	Difficulty Tab
	Difficulty
	Maze-Phrase Tab
	Maze-Phrase
	Maze-Phrase Solution Options
	Printing Tab
	Printed Pages
	Stats Tab
	Maze Preview on the Right
	More goodies for you! Button
	Help (User Guide) Button
	Export Button
	Print Button
	Build Button
	Menus at the Top
	Minos Maze Maker menu
	Minos - About Minos Maze Maker
	Minos - Settings
	Minos - Save Document Settings as Defaults
	Minos - Reset Document Settings to Saved Defaults
	Minos - Reset Document Settings to Factory Defaults
	Minos - Change All Colors to B&W
	Minos - Pro Upgrade…
	File menu
	File - New
	File - Open/Save
	File - Revert to
	File - Export Maze
	File - Print
	Edit menu
	Action menu
	Action - Build Maze
	Action - Shape Editor (Pro Feature)
	Action - Bulk-Builder (Pro Feature)
	Action - Daily Maze (Pro Feature)
	View menu
	Window menu
	Help menu
	Help - Minos Maze Maker User Guide
	Help - Minos Maze Maker Introduction
	Help - Next User Tip
	Help - Bulk Builder - Guide
	Help - ESP File Export Guide
	Help - What’s New
	Help - Compare Features (Pro/Full/Lite)
	Help - Rate/Review Minos Maze Maker
	Help - Contact Author
	Help - Minos Maze Maker Product Web Page
	Help - More Fun Products
	Help - Company Web Page
	Settings Window
	Appearance Tab
	Author Info
	SVG Export Tab
	More Information

